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Colophon
FACE™ MagicDraw Plugin for Edition 3.0 has been approved for public release by DEVCOM AvMC
with public release number: PR20210291

DISTRIBUTION STATEMENT A. Approved for public release; distribution is unlimited.

Copyright (c) Vanderbilt University, 2022

ALL RIGHTS RESERVED, UNLESS OTHERWISE STATED

This software, authored by Vanderbilt University under a contract awarded to and managed by
Alion Science and Technology, was funded by the U.S. Government under Contract No. FA8075-14-D-
0014 and the U.S. Government has unlimited rights in this software. An “unlimited rights” license
means that the U.S. Government can use, modify, reproduce, release or disclose computer software
in whole or in part, in any manner, and for any purpose whatsoever, and to have or authorize
others to do so.

Vanderbilt University disclaims all warranties with regard to this software, including all implied
warranties of merchantability and fitness. In no event shall Vanderbilt University be liable for any
special, indirect or consequential damages or any damages whatsoever resulting from loss of use,
data or profits, whether in an action of contract, negligence or other tortious action, arising out of
or in connection with the use or performance of this software.

1. Introduction
MagicDraw is a modeling tool developed by No Magic. More information on this tool can be found
at: https://www.nomagic.com/products/magicdraw Future Airborne Capability Environment
(FACE™) is a consortium developed standard. More information on this standard can be found at:
https://www.opengroup.org/face This document provides information on the installation and use of
the following plugins running within MagicDraw:

• FACE 3.0 MagicDraw Model-Tool-Interchange Plugin

• FACE 3.1 MagicDraw Model-Tool-Interchange Plugin

Note: "Model-Tool-Interchange Plugin” is synonymous with “Import/Export Plugin”.

Note: An * will be used when the version number is referenced that applies to any version of the
plugin.

Note: The "Model-Tool-Interchange Plugin” is delivered in a zip file. That zip file contains only one
version (i.e. 3.0 or 3.1 but not both) of the software. Therefore, if you are installing the 3.0 version,
none of the 3.1 capabilities would be available.

The plugins perform two functions as follows:

• Import an Extensible Markup Language (XML) Metadata Interchange (XMI) file (i.e. .face file)
into an MagicDraw model
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• Export an MagicDraw model to XMI file (i.e. .face file)

The FACE Technical Standard Edition defines the meta-model and XMI schema that are used to
create MagicDraw data models and XMI files. These documents can be found at:
https://prod.opengroup.org/face/docsandtools

2. FACE™ 3.* MagicDraw Model-Tool-
Interchange Plugin Setup
This section describes the steps necessary to setup the FACE MagicDraw Model-Tool-Interchange
Plugin.

2.1. Prerequisites
The prerequisites for the FACE 3.* MagicDraw Model-Tool-Interchange Plugin Setup follow:

• Version of Java as specified by https://www.nomagic.com/support/jvm-list

• MagicDraw version 18.5 or 19.0

2.2. Installation
Installation for each of these sections will start in the MagicDraw installation directory (C:\Program
Files\MagicDraw by default).

These instructions are based off the plugin installation directions found here:
https://docs.nomagic.com/display/NMDOC/Installing+plugins

If you do not have admin access to your machine, you can install the plugin in an alternative
location the user defines such as C:\Users\<username>\AppData\Local\.magicdraw<version>} To get
the exact path to the configuration files follow the instructions below:

• Open the help menu and select About MagicDraw.

• From the Help menu, select About MagicDraw. The About screen opens.

• Click the Environment tab.

• Click the hyperlink next to Configuration files. The folder containing MagicDraw configuration
files opens.

Additional information can be found here: https://docs.nomagic.com/display/MD185/
Plugins+directories

2.3. Install Plugin
To install the FACE MagicDraw Model-Tool-Interchange open the plugin directory in the MagicDraw
installation directory (C:\Program Files\MagicDraw by default) or Cameo (C:\Program Files\Cameo
Systems Modeler by default) and copy the FACE 3.* MagicDraw Model-Tool-Interchange Plugin into
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this directory. If you have magic draw open when you install the plugin you will need to restart the
application.

2.4. Install Profile
Within the plugin package is a directory called "profile" which contain the following based on the
plugin version:

• FACE 3.0 Plugin

◦ FACE_3.0_Unified_Profile_Customizations_v1.mdzip

◦ FACE_3.0_Unified_Profile_v1.mdzip

• FACE 3.1 Plugin

◦ FACE_3.1_Unified_Profile_Customizations_v1.mdzip

◦ FACE_3.1_Unified_Profile_v1.mdzip

These files need to be copied into the profile folder of the MagicDraw installation directory
(C:\Program Files\MagicDraw by default). This is important if you do not want to use the Starter
Model to initialize a new project.

2.5. Setting Up Custom Diagrams
Begin by opening MagicDraw and selecting "Diagrams" in the tool bar. Navigate to Customize; you
many need to expand the menu to see this option.

Now select "Import" and navigate to the FACE 3.* MagicDraw Model-Tool-Interchange Plugin
installation directory (C:\Program Files\MagicDraw\plugins\edu.vanderbilt.isis.bns.md_v3* by
default) then open the diagrams folder. You will need to import each of these diagrams for the full
functionality of the tools and models be accessed.

Once you have completed this process the custom diagrams should have each of the following
entries:

• FACE 3.0 Plugin

◦ FACE Architecture Model Diagram

◦ FACE Conceptual Data Model Diagram

◦ FACE Data Model Diagram

◦ FACE Integration Context Diagram

◦ FACE Integration Model Diagram

◦ FACE Logical Data Model Diagram

◦ FACE Platform Data Model Diagram

◦ FACE Traceability Model Diagram

◦ FACE UoP Model Diagram

• FACE 3.1 Plugin
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◦ FACE 3.1 Architecture Model Diagram

◦ FACE 3.1 Conceptual Data Model Diagram

◦ FACE 3.1 Data Model Diagram

◦ FACE 3.1 Integration Context Diagram

◦ FACE 3.1 Integration Model Diagram

◦ FACE 3.1 Logical Data Model Diagram

◦ FACE 3.1 Platform Data Model Diagram

◦ FACE 3.1 Traceability Model Diagram

◦ FACE 3.1 UoP Model Diagram

Figure 1. Loading Custom Diagrams for FACE

3. FACE v3.* MagicDraw Model-Tool-
Interchange Plugin Usage
This chapter will discuss the functionality of the FACE v3.* MagicDraw Model-Tool-Interchange
Plugin and how to set a project up to take advantage of this capability. Below in Import/Export GUI
is the FACE v3.* MagicDraw Model-Tool-Interchange Plugin interface.
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Figure 2. Import/Export GUI

The Plugin has 4 main sections. Section 1 is used to define import, export, and log file paths. This
section provides the ability to lock the paths for import and export to prevent accidental name
change. You can also enable or disable logging from here as well. Section 2 is used to initiate import
or export of a model. These buttons are context sensitive based upon what elements in the
containment tab are currently highlighted. The About button opens up the additional options seen
in Section 3. These options contain a variety of useful resources for the user. Section 4 is a console
feed for that reports the status of an import or export as it is happening.

The plugin can be accessed from any open MagicDraw project once the plugin has been installed as
described in Chapter [FACE 3.* MagicDraw Model-Tool-Interchange Plugin Setup] by opening the
context menu from the Containment Tab within MagicDraw (Figure FACE Import/Export
Architecture Utility).

WARNING – You must select an element in the containment tree (e.g. Model) before right clicking to
open the context menu. This indicates the package to import into or export from. Failing to select
the containment tree element will cause the plugin to fail on imports/exports.
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Figure 3. FACE Import/Export Architecture Utility

7



3.1. Setup a New Project
From a newly created MagicDraw Project, open the context menu in the Containment Tab and
navigate to "Import/Export Architecture Model XMI". This will open the FACE v3.* Import/Export
Architecture Model XMI Utility.

Figure 4. FACE v3.* Import/Export Architecture Model XMI Utility

Click the "About" Button to open a menu of options. From this list select "Open MagicDraw FACE
Starter Model". Once the model opens, Save-As to the location you want to store your project.

WARNING – You must always start with the starter model. This model has the profile and
customizations that are needed to create a FACE model. The plugin will not work without the
profile and customizations. In addition to using the About menu above to obtain the starter model,
you could copy the model from the MTI zip file directory "models\starter_model” under the
“edu.vanderbilt.isis.bns.md_v30/31” directory. Once copied to a new location, it should be renamed
to reflect the model purpose.

3.1.1. Creating FACE Architecture Models

With a project set up with steps detailed in section Setup a New Project you can now use the tools to
begin creating a FACE Architecture Models.

First create a package and stereotype it as <FACEArchitectureModel>. Any child elements, diagrams,
and relationships of this package will only be those allowed in the <FACEArchitectureModel> based
upon the context you are modeling. For example, Observables can only be created in Conceptual
Models. These elements will also be color coded. When creating diagrams, the pallet will be filtered
based upon the type of diagram you are constructing.
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3.2. Model-Tool-Interchange Plugin Usage
A MagicDraw project must be setup per Chapter Plugin Setup, and one of Sections Setup a New
Project or Advanced Users with a MagicDraw FACE 3.* profile setup before importing or exporting a
FACE Architecture Model (i.e. .face XMI file). Note: You can only import a FACE 3.* XMI file into an
MagicDraw model that has the corresponding FACE profile.

3.2.1. Importing and Export

Importing and Exporting are available based on the context selected in the Containment Tab. When
Exporting a model, all children of the package with a stereotype of <FACEArchitectureModel> will
be export to a FACE XMI file. Importing a FACE XMI will create packages with the
<FACEArchitectureModel> stereotype that will contain imported FACE XMI model.

The model will be import or exported based on the file paths in section (1) of the plugin. These
paths are generated based on the location of the MagicDraw project. You can change these paths to
a custom destination. If you do, make sure to select the "Protect" box as the path will change if
another project is selected. While a model is being transformed to or from the MagicDraw project,
the status will be displayed in the console (4) within the plugin interface. If there are any errors
that occur during the import or export they will also be displayed here as well.

Figure 5. FACE XMI Export in progress

3.2.2. About

The about button brings up a menu of options. These include the license information, revision
history, User Guide(the document you are currently reading), and known issues. Additionally there
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are links to several useful models and the profile supported by the tool. console (3) shows the
complete menu.

Figure 6. About Menu

Some MTI versions have an extra text box in the About panel as shown in the following figure (
console (3.5))

Figure 7. About Menu with Added Text Box

3.3. Advanced Users
For advanced users who find the automation to be cumbersome or that interferes with experiments
using FACE in novel ways, it is possible to load the profile with out the additional support functions.
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Go to:

• "File"→"Use Project"→"Local Project".

Next select "<install.root\profiles>" from the "Paths to used Projects" then navigate to
"FACE_3.*_Unified_Profile_v*.mdzip" as seen in Advanced User. This will load the base profile with
no customizations or automation to facilitate your experimentation. You can also use the plugin to
load this profile from the about menu.

Figure 8. Using Profile without Customizations

The spreadsheet at C:\Program
Files\MagicDraw\plugins\edu.vanderbilt.isis.bns.md_v3*\profiles\FACE_3.Unified_Profile_v1.xlsx
contains the intended usage of each element in FACE_3.*_Unified_Profile.mdzip to help ensure
you are using them in the intended manner.

Note: The customizations do not cover all use cases

4. Models
Two Magic Draw models are included with the plugin: MagicDraw Coverage Test Model.mdzip and
FACE30StarterModel.mdzip. These models are included to help the user get started modeling
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quickly and to have an in tool reference for how each element in the profile should be represented.

4.1. MagicDraw Coverage Test Model
This model includes examples of how to each element from the profile to construct a
FACEArchitectureModel. This model is not valid, and is only intended demonstrate the correct
usage of each UML element within Magic Draw.

This model is also intended to be used as a tool to validate installation of the Profile and Model-
Tool-Interchange Plugin. You should be able to export and import this model with no errors. You
can compare the exported model to the included FACE XMI model
(FACE30_ToolingCoverageModel.face) with the plugin package to confirm the export was successful.

4.2. Starter Model
This model is preconfigured with the profiles customizations allowing for users to more quickly
begin modeling using the tools provided. When using this model you will need to save a copy of the
project before making edits to ensure the template remains intact.

5. Modeling Examples

5.1. External References
A model could consist of all the contents residing under a package stereotyped with
FACEArchitectureModel (i.e. FACEArchitectureModel package). For example,
FACEArchitectureModel package could contain:

• FACEDataModel 0..*

• UoPModel 0..*

• IntegrationModel 0..*

• TraceabilityModel 0..*

However, this approach is limiting. To provide greater flexibility, SmartPackages are used to
reference entities that are not directly subordinate to the FACEArchitectureModel package.

Note - SmartPackages are supported in MTI v2021.10.0 and later.

Notice in the following figure (SmartPackage Used to Reference External Entities) that
MyArchitecture<<FACEArchitectureModel>> contains two SmartPackages identified as
SDM_Reference and UoP_Reference. Under the SDM_Reference SmartPackage there is a reference
to SDM_3_0_2<<FACEDataModel>>, which points to SDM_3_0_2<<FACEDataModel>> under
SDM_30[SDM_30.mdzip]. Notice that the model for this reference is in an external model named
SDM_30.mdzip. The example illustrates referencing an external model for a portion of the content
of the FACEArchitectureModel.

The second example shown in the figure is the UoP_Reference SmartPackage. For this case, the
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model referenced is contained in the MD project (i.e. not an external MD project). Under the
UoP_Reference SmartPackage is a reference to UoPModel<<UoPModel>>, which points to
UoPModel<<UoPModel>> under the UoPModels package.

Figure 9. SmartPackage Used to Reference External Entities

Notes:

• Cardinality Rules – A FACEArchitectureModel can contain zero to many SmartPackages. A
SmartPackage can contain zero to many references to models of stereotype of FACEDataModel,
UoPModel, IntegrationModel, and/or TraceabilityModel.

• FACE Hierarchy Rules - A FACEDataModel cannot contain a FACEDataModel. However, a
UoPModel can contain a UoPModel, an IntegrationModel can contain a IntegrationModel, and a
TraceabilityModel can contain a TraceabilityModel. For those cases, a SmartPackage may
appear at any level in the containment structure. In other words, if a UoPModel contains a
UoPModel, a SmartPackage may appear at the top-level UoPModel and/or the subordinate level
UoPModel.

• MTI Search of SmartPackages - It is important to understand that only the immediate
SmartPackage is searched for FACE references. In other words, if a SmartPackage contains a
SmartPackage, then only the highest level SmartPackage would be searched for FACE
references.
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6. Customizations

6.1. Customizing Diagrams
The section Setting Up Custom Diagrams describes how to setup the diagrams that define the tool
palettes for each diagram type. You may wish to add additional tools to the tool palettes. To do so,
within MagicDraw, select Diagrams Customize and select one of the Diagrams and select Edit.
Follow the prompts to edit the diagram. See MagicDraw documentation for additional information.
The plugin ignores entities that are not stereotyped with a FACE stereotypes; and thus, your non-
FACE additions will not be exported.

7. Additional Information

7.1. Compatibility between FACE Editions
The FACE 3.0 MagicDraw plugin can only be used with MagicDraw models and XMI files (i.e. .face
files) created for FACE 3.0.

The FACE 3.1 MagicDraw plugin can only be used with MagicDraw models and XMI files (i.e. .face
files) created for FACE 3.1.

7.2. Testing History
There are limited resources to test the plugins on multiple operating systems and with multiple
versions of MagicDraw. The following table provides information on the level of testing that has
been conducted.

7.2.1. FACE 3.0 MagicDraw Model-Tool-Interchange Plugin

Plugin Version Operating System MagicDraw Version Test Scope

2019.9.0-BETA Windows 10 18.5, 19.0 (Import Only) Testing with coverage
model

2019.10.0-BETA Windows 10 18.5, 19.0 (Import Only) Testing with coverage
model, BALSA, and
other models

2019.11.0-BETA Windows 10 18.5, 19.0 Testing with coverage
model, BALSA, and
other models
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2020.2.0 Windows 10 18.5, 19.0 Testing with coverage
model, BALSA, and
other Models

2021.7.0 Windows 10 18.5, 19.0, 2021 Testing with coverage
model, BALSA, and
other Models. Note -
MD v2021 (i.e. Cameo
2021) had anomalies;
and thus, Cameo 2021
should not be used. For
Cameo 2021, the
import/export worked
correctly, but logging
and display of
messages to the UI
window did not work
correctly.

2021.7.1 Windows 10 18.5, 19.0 Due to only a minor
change (notification
events call) to the UI,
only a subset of the
2021.7.0 tests were
conducted.

2021.8.0 Windows 10 18.5, 19.0 Due to only a minor
change to the About
panel, only a subset of
the 2021.7.0 tests were
conducted.

2021.10.0 Windows 10 18.5, 19.0 Testing with coverage
model, BALSA, and
other Models

7.2.2. FACE 3.1 MagicDraw Model-Tool-Interchange Plugin

Plugin Version Operating System MagicDraw Version Test Scope

2020.5.0-BETA Windows 10 18.5, 19.0 Testing with coverage
model, BALSA, and
other Models
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2020.8.0 Windows 10 18.5, 19.0 Testing with coverage
model, BALSA, and
other Models

2020.2.0 Windows 10 18.5, 19.0 Testing with coverage
model, BALSA, and
other Models

7.3. Bug Reports
Send all bug reports and improvement suggestions to robert.l.owens@vanderbilt.edu.

8. Troubleshooting

8.1. Unresolved GUID
Possible Causes The referenced element GUID was not exported because it is defined as a child of
an element is not owned by a parent.

8.1.1. Example

A Connection(QueuingConnection, SingleInstanceMessageConnection, ClientServerConnection)
element is an end point for a Unit of Portability. Then the Connection(QueuingConnection,
SingleInstanceMessageConnection, ClientServerConnection) is used as MessageType to a Platform
View.

8.2. Installation of MagicDraw in a Non-Standard (i.e.
not Program Files) Location Known Issues
Under the following conditions, the Importer/Exporter Plugin may not appear when right clicking
on an item in the MagicDraw containment tree:

1. MagicDraw installed in a non-standard location.

2. Start MagicDraw with the icon setup by the MagicDraw installer. This is just a shortcut to the
MagicDraw exe (magicdraw.exe)….

MagicDraw installed in a non-standard location. Start MagicDraw with the icon setup by the
MagicDraw installer. This is just a shortcut to the MagicDraw exe (magicdraw.exe).

If this condition occurs, a workaround is to start MagicDraw by double clicking on the exe
(magicdraw.exe) located in the bin folder of the installation directory. Another workaround is to
delete the shortcut created by the MagicDraw installer, and manually recreate the shortcut.
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8.3. Inconsequential Logging Error Messages
The log file may contain errors ( i.e. [ERROR]), which are artifacts of configuring logging. These
errors will contain the string “PerObject”. When reviewing the log file, these errors should be
ignored. They are not relevant to the model being valid/invalid.

8.3.1. Example

[ERROR]
edu.vanderbilt.isis.face.v31.architecturemodel.transform.model2model.executor.Model2Mo
delTransformExecutor.PerObject.2 -
[INFO ] edu.vanderbilt.isis.common.logger.ListAppender - Registering
"edu.vanderbilt.isis.face.v31.architecturemodel.transform.model2model.executor.Model2M
odelTransformExecutor$$Lambda$709/1806812515" listener for logger
"edu.vanderbilt.isis.face.v31.architecturemodel.transform.model2model.executor.Model2M
odelTransformExecutor.PerObject.2"
[ERROR]
edu.vanderbilt.isis.face.v31.architecturemodel.transform.model2model.executor.Model2Mo
delTransformExecutor.PerObject.2 -
edu.vanderbilt.isis.face.v31.architecturemodel.transform.model2model.executor.Model2Mo
delTransformExecutor$$Lambda$709/1806812515@1fd66a5c

9. Acronyms
Acronym Description

FACE Future Airborne Capability Environment

MTI Model Tool Interchange

XMI Extensible Markup Language Metadata
Interchange

XML Extensible Markup Language

10. Version History
Revision Date Authors(s) Description

2019.9.0 10/25/2019 FE,RD,RO,JH Initial Publication

2019.10.0 10/25/2019 JH Added instructions for
installing the plugin
without Admin
privileges
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2019.11.0 11/22/2019 JH Added Troubleshooting
section in Appendix A

2020.2.0 02/21/2020 JH,RO • Corrected an error
in the Install Plugin
section.

• "copy the FACE 3.0
MagicDraw Model-
Tool-Interchange
Plugin into this
directory" was
ambiguous.

• Updated to name
the directory to
copy.

• Updated Images to
Reflect Current
Tool. Added
instructions for
installing with
Cameo.

• Added "Standard
Workflow" section

2020.5.0 06/03/2020 JH Added 3.1 support in
document

2020.8.0 08/12/2020 RO Updated test scope to
indicate the testing that
was done for version
2020.8.0

No formal revision 10/08/2020 RO Updated the Vanderbilt
copyright notice with
the latest wording.
Corrected several
typographical and
section reference
errors.
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2021.7.0 7/14/2021 RO Updated Figure FACE
Import/Export
Architecture Utility to
show the version (i.e.
3.0) number in the
dropdown menu.

2021.8.0 8/25/2021 RO Added an extra About
Figure, About Menu
with Added Text Box.

2021.10.0 10/6/2021 RO Added Sections
External References
and Customizing
Diagrams.

2021.10.0_A 2/7/2022 RO Added a WARNING in
Section FACE v3.*
MagicDraw Model-
Tool-Interchange
Plugin Usage to select
an element in the
containment tree.
Added a WARNING in
Section Setup a New
Project to always start
with the starter model.
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